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HQ EPCS Reviewing Official Guide
Completing Second Level Reviews for the 2015 – 2016 Appraisal Cycle

To help ensure the performance rating process is fair and contributes in a meaningful way to the accomplishment of NASA objectives, EPCS requires second level review of all ratings.  The second level review must be completed in the Standard Performance Appraisal Communication Environment (SPACE). 
Why is a Second Level Review required?
The purpose of the second level review is to look at rating levels across an organization, to observe trends, consistency, potential disparities and other relevant factors, which may reflect concerns that should be addressed.  Examples include apparent inconsistency between rating officials and/or potential disparity in ratings between groups of employees.
The purpose is not to approve every individual rating; a second level approval is only required for individual ratings of Unacceptable. In addition, a Second Level Review is not required when the Rating Official is an AA or Official in Charge, or his/her direct report.
Conducting a Second Level Review
Ratings must be completed in SPACE by June 30, 2016.  Completed means that ratings must have been:
· Reviewed in SPACE by the Reviewing Official
· If applicable, Unacceptable ratings approved by Reviewing Officials 
· Finalized by Rating Officials (to include incorporating any feedback received from the second level review) 
· Communicated to employees through face-to-face discussions, and 
· Signed by Rating Officials and employees
[bookmark: _GoBack]To meet the June 30, 2016 deadline, we recommend that you require Rating Officials to submit all proposed ratings in SPACE by May 20, 2016. After proposed ratings are submitted, you may begin your second level review.  Second level reviews should be completed by June 3, 2016.  Once completed, ratings will remain locked to allow time for the Higher Level Review, if applicable. On June 10, 2016 ratings will be released back to Rating Officials so that they may be finalized and communicated to employees. 
The second level review is conducted only once.  Before the second level review process can be completed, all proposed ratings must have been submitted, or the Rating Official must indicate, in SPACE, a reason why they have not been submitted. You have the option to view and edit the incomplete/late reason prior to completing your review.  To check the progress of Rating Officials in submitting proposed ratings, on your Supervisor View tab select Non-Direct Reports (Second Level Review) from the Select View drop-down menu. Employees for whom a proposed rating has been submitted will have a status of “Rating Waiting for Second Level Review.” Reach out to any Rating Officials who have not submitted proposed ratings or documented reasons specific ratings are not required in SPACE. 

Completing Your Review
For step-by-step instructions on completing your second level review in SPACE, review the “Conducting Second Level Review” job aid, available on the Center Reference Guide tab in SPACE and accessed from the Agency References section by clicking on the NASA Human Resources Portal Performance Management link.

To begin your second level review, log into SPACE and select Performance Year 2016 from the Select Performance Year drop-down menu (if not already selected). Click the Second Level Review tab (next to the Supervisor View tab). You may sort your reviewees by clicking any of the available column titles. You may also export the information on your Second Level Review tab to Excel by clicking the Excel button located at the top of the tab. Clicking Excel will generate the Second Level Review Report, which can be sorted in different ways to assist you in reviewing ratings.  For example, sorting the data by organization, Rating Official, rating level or grade level may offer the potential to note observations that may not be evident using just one of these approaches.  See Appendix A for a detailed guide to retrieving and using the Second Level Review Report.

The purpose of the second level review is to look at rating levels across an organization and to observe trends, consistency, and other things that might need further investigation.  When conducting your review, look for things such as:
· Noticeable differences between ratings done by different supervisors
· Rating levels that aren’t consistent with what you know of an individual’s or an organization’s performance 
· Inconsistency between the ratings of an organization’s supervisors and its employees 
· Significant changes in the ratings of a group of employees since the previous year
· Noticeable differences between employees with different occupations, grade levels, or demographic characteristics 
 
If you observe potential disparities/inconsistencies, scrutinize the relevant performance plans and ratings to identify any underlying causes.  In particular, consider whether:
· Narrative justifications are substantive and support the summary ratings assigned
· Subordinate supervisors have demonstrated performance consistent with the rating assigned in the two supervisory elements
· Performance standards are sufficiently rigorous, and are consistent with the grade level, the employee’s responsibilities, and the goals/objectives of the Agency and the organization 

Even if you do not observe potential disparities or inconsistencies, you should review a sampling of individual ratings, preferably one or more from each Rating Official, to evaluate the quality of narrative justifications and to consider the need for possible improvements to performance plans for the upcoming cycle.  Your review provides valuable information to support the performance evaluation of your subordinate supervisors, and can assist you in giving them feedback.  See Appendix B for detailed guidance on how to access employee performance records in SPACE.



Providing Feedback and Direction to Subordinate Supervisors:
· You may require Rating Officials to reconsider individual ratings and/or provide additional justification.  SPACE now has the option to return a rating to your subordinate supervisors via a Return Rating icon located in the Proposed Rating or Incomplete Reason column on the Second Level Review page
· You may not establish specific rating distributions (i.e., you may not simply direct that ratings be raised or lowered to meet a distribution level)
· You may require changes to improve organizational performance plans for the upcoming cycle
· Feedback on returned ratings must be provided outside SPACE
· Ratings that are changed do not require a second round of review before they can be finalized and issued to employees.  Therefore, follow-up outside SPACE is needed to ensure that subordinate supervisors have addressed your guidance or direction  

Documenting Your Review
Along with your review of proposed ratings, you must complete two additional steps:
· Document reasons for incomplete ratings. If a proposed rating has not been submitted for a legitimate reason, and your subordinate supervisor has not already indicated a reason for a late or incomplete rating, select the reason from the drop-down menu in the Proposed Rating or Incomplete Reason column.
· Approve Unacceptable ratings, if applicable. Unacceptable ratings will be highlighted in yellow. See Appendix B for instructions on how to approve Unacceptable ratings. 
Once you have reviewed all proposed ratings, ensured SPACE has reasons for all applicable incomplete ratings, and approved Unacceptable ratings (if applicable), click the Complete Review button at the top of the tab. Click the Confirm button on the Review Ratings pop-up to certify completion of the second level review.
 If you have any questions, or need any assistance with the review process, please contact Mr. Ronald “Ronnie” Farrell, Performance Management Program Manager, at (202) 358-1479.





APPENDIX A:  The SPACE Second Level Review Report

Retrieving the Second Level Review Report  

To run the Second Level Review Report in SPACE:
· Go to the HR Portal: https://hr.nasa.gov/  
· Click the SPACE link in the Systems Launcher
· Click the  Second Level Review tab
· Click the Excel button
· Click the Open button on the pop-up
· Click the Yes button, if you receive a second pop-up warning

*Note: Higher level Managers may also access this report for their assigned Organizations by clicking the Reports tab at the top of the SPACE homepage. Click the Second Level Review Report link in the SPACE Reports section. Select the Organization you wish to review from the Select Organization drop-down menu and click the Excel button.

About the Second Level Review Report
The report appears in alphabetical order by Org Code.  Use the Sort and Filter features in Excel to change the alignment of the data.  Examples of how to use both features, as well as a more detailed description of the column titles, are provided below.

On the “Second Level Review Report” tab:
Employee Name – the name of the employee, appearing as “Last Name, First Name”
Employee UUPIC – the employee’s UUPIC
Employee Title – the employee’s position title
Series – the employee’s occupational series
Grade – the employee’s grade
Is Employee a Supervisor– if the employee is a supervisor, a Yes will be in this column
Org Code – the employee’s organization code
Organization Name– the name of the employee’s organization
Rating Official – the employee’s designated Rating Official
Previous Year Rating – the employee’s rating from the previous appraisal cycle, if it was done in SPACE
Rating – the employee’s summary (i.e., overall) rating level
Rating Status – the status of the employee’s rating as of the time the report was pulled
· Proposed: The rating has not been communicated to the employee and is currently proposed for second level review
· Signed: The rating has been communicated to the employee and has been signed by the Rating Official
Rating Proposed By – the SPACE user who submitted the proposed rating
Rating Proposed Date – date the rating was proposed
Second Level Review Date – date the second level review was completed
Note: This column will read “N/A” for any employees who are excluded from a Second Level Review
Rating Signed By – the SPACE user who signed the employee’s rating
Early Rating Comments – if completed early, the reason the rating was completed prior to the rating cycle

On the “Rating Not Submitted” tab:
Employee Name – the name of the employee, appearing as “Last Name, First Name”
Employee UUPIC – the employee’s UUPIC
Employee Title – the employee’s position title
Series – the employee’s occupational series
Grade – the employee’s grade
Is Employee a Supervisor– if the employee is a supervisor, a Yes will be in this column
Org Code – the employee’s organization code
Organization Name– the name of the employee’s organization
Rating Official – the employee’s designated Rating Official
Previous Year Rating – the employee’s rating from the previous appraisal cycle, if it was done in SPACE
Rating – the employee’s summary (i.e., overall) rating level
Rating Status – the status of the employee’s rating as of the time the report was pulled
· Proposed: The rating has not been communicated to the employee and is currently proposed for second level review
· Signed: The rating has been communicated to the employee and has been signed by the Rating Official
Incomplete Reason – the reason the proposed rating was not submitted for second level review

To Sort (by Rating Official)
1. Select the Rating Official cell (Row 3, Column I)
2. Select the Data tab at the top of the screen
3. Click the Sort button
4. In the Sort by drop down select Rating Official
5. Click the OK button

To Filter (by Org Code)
1. Select the Org Code cell (Row 3, Column G)
2. Select the Data tab at the top of the screen
3. Click the Filter button
4. Click the down arrow next to Org Code
5. Select/deselect the checkboxes next to the Org Code(s) to indicate which ones should appear



APPENDIX B:  Reviewing Individual Ratings and Performance Information in SPACE

1. Select the Supervisor View tab, if not already selected
2. In the Select View drop down, click the applicable view option 
· The Non-Direct Reports (Second Level Review) will display a list of all employees for whom the user is designated as the “Reviewing Official” 
· You may also select an organizational view to which you have access
3. Click the hyperlink of the employee’s name
4. Select the Plan Summary tab, if not already selected, to view the employee’s performance plan
· Click the Element link to view more information about the element, including the employee’s comments regarding the performance plan
5. Select the Ratings tab to view the employee’s rating
· Click the View Rating button to view the employee’s proposed rating (e.g., performance plan, individual element ratings, narrative summary and any element feedback)
· To approve a proposed Unacceptable rating, review the rating levels for each Critical Element and then click Approve Rating at the bottom of the page and then click Confirm
6. The other tabs provide other additional performance information:
· Select the Progress Review(s) tab to view the Midpoint and any other progress reviews
· Select the Employee Provided Self-Assessments tab to view the information provided by the employee about his/her performance during the performance year
· Select the Supplemental Feedback tab to view feedback from third parties regarding the employee’s performance (e.g., team leads, matrix supervisor, detail supervisor, customer)
· Select the Historical Plans tab to view the any previous versions of the performance plan during the applicable cycle.
7. You may print any of the documents that you view in SPACE.
8. Select the Home tab, in the upper left-hand corner to return to the Supervisor View (e.g., to view other employees’ information)
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